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Toivomme, että hdd-soittimesta on sinulle iloa

Käy osoitteessa www.philips.com/support
Kirjoittamalla tuotteen nimen voit tarkastella:

· Usein kysyttyjä kysymyksiä (FAQ)
· Uusimpia käyttöoppaita
· Uusimpia ladattavia ohjelmia
· Päivitystiedostoja

Suosittelemme, että rekisteröit tuotteen sivustossa
www.philips.com/register, jotta voimme ilmoittaa sinulle,
kun tuotteeseen on saatavana päivityksiä.

Arvokilpi on laitteen takana

Suomi
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Pikaopas

1 Lataa akku
Kytke tuotteen mukana toimitettu monijännitteinen
verkkolaite/laturi viiden voltin tasavirtaliitäntään ja verkkovirtaan.
Lataa 4 tuntia, jotta akku latautuu täysin. Pikalataus: 1 tuntia.
(Akun käyttöikä voi vaihdella käytön mukaan.)

2 Musiikinhallintaohjelmiston asentaminen
Pane tuotteen mukana toimitettu CD-levy tietokoneen 
CD-asemaan. Suorita asennus noudattamalla näyttöön 
tulevia ohjeita.

HUOMAUTUS:
WINDOWS 98SE -KÄYTTÄJÄT:
Vältät asennusongelmia, kun kytket hdd-soittimen tietokoneeseen vasta SEN JÄLKEEN,,
kun ohjelma on asennettu.

3 Kytke hdd-soitin tietokoneeseen
Kytke hdd tietokoneeseen tuotteen mukana 
toimitetulla USB-kaapelilla sen jälkeen, kun 
hdd-soittimen virta on kytketty tuotteen mukana
toimitetulla sovittimella. Näyttöön tulee 
automaattisesti USB-yhteyden näyttö.
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4 Järjestä ja siirrä musiikkia
Käynnistä musiikinhallintaohjelmisto Windowsin työpöydältä
tai Käynnistä-valikosta.
Järjestä kappaleet ja soittolistat.
Siirrä musiikkitiedostoja tietokoneesta hdd-soittimeen.

5 Irrota hdd-soitin 
Musiikinhallintaohjelman lopettaminen.
Irrota hdd varovasti tietokoneesta valitsemalla työkaluriviltä 
Näin vältät tiedostovirheet. (WINDOWS 98SE -käyttäjät: -kuvaketta ei ole.
Irrota hdd suoraan, kun tiedostonsiirto on suoritettu.)

6 Käytä sitä kannettavana soittimena
Kytke virta pitämällä 2; painettuna.
Selaa kappaleita selauspainikkeilla ja nauti musiikista painamalla 2; -painiketta.

➯ VIHJE
Lisätietoja on valitun ohjelmiston ohjeessa.
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Vasen Oikea
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Liitäntöjen ja käyttöpainikkeiden yleiskatsaus

1 p Kuulokeliitäntä

2 USB USB-kaapeliliitäntä

3 5V DC Muuntajan liitäntä

4 VOLUME + / – Äänenvoimakkuuden säätö 

5 MENU/HOLD Avaa komentovalikon ja lukitsee painikkeet / Pikavalintakanavien virittäminen

6 SOURCE Avaa musiikkikirjaston asetukset /Radio

7 2; Kytkeminen / Katkaiseminen ja Toisto / Tauko

8 2 Oikealle

9 4 / 2™ Seuraava / Eteenpäinhaku / SuperScroll™

0 1 Vasemmalle

! 3 / ¡1 Edellinen / Taaksepäinhaku / SuperScroll™
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Hdd-soittimen näyttö

Akun tason ilmaisin Verkkovirta kytketty 

Musiikkitila Radiotila

Soittolista Albumi

Tyylilaji Esittäjä

Kaikki Taajuuskorjain

< Edellinen käytettävissä oleva  > Seuraava käytettävissä oleva  
valikko tai kirjastotaso valikko tai kirjastotaso

Uusinta 1 Uusinta kaikki

Satunnaistotoisto Dynamic Bass Boost valittu

Valittavissa oleva asetus Valittu asetus

Hdd-soittimen näytössä on monenlaisia tietoja:

Musiikkitila:Toistaminen

1 Siirry musiikkitilaan valitsemalla juurivalikosta HDD.

2 Selaa haluamasi asetuksen kohdalle painamalla 3 - tai 4 -painiketta.
Siirry seuraavalle tai edelliselle kirjastotasolle painamalla 2 - tai 1 -painiketta.

3 Aktivoi valinnan toistaminen painamalla 2; -painiketta.

VIHJE
2;,- 3 - ja 4-painikkeet ovat monitoimisia. Painikkeet toimivat sen mukaan, kuinka
painat niitä: painamalla painikkeen puoliväliin, painamalla sen kokonaan alas tai 
painamalla painiketta ja pitämällä sitä alhalla.

➯
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Hdd-soittimen painikkeiden käyttäminen

Vianmääritys Painettavat painikkeet

Hdd-soittimen Paina ja pidä alhaalla 3 + [VOLUME +] -painiketta
asetusten palauttaminen
Hdd-soittimen tehdasasetusten Selaa Restore settings (Palauta tehdasasetukset) 
palauttaminen -kohtaan painamalla MENU/HOLD-painiketta.

Vahvista painamalla 2-painiketta

Perustoiminto Painettavat painikkeet

Hdd-soittimen virran Paina ja pidä alhaalla 2; -painiketta
kytkeminen ja katkaiseminen
Kirjastoasetusten avaaminen Valitse näytöltä 1
Radiotila Siirry radiotilaan valitsemalla juurivalikosta RADIO.
Painikkeiden lukitseminen Paina ja pidä alhalla MENU/HOLD-painiketta
tai vapauttaminen
Valikon eri tasoille siirtyminen Seuraava taso 2 -painikkeella ja edellinen 1 painikkeella
Selaaminen 3, 4, 1, 2 ylös, alas, vasemmalle, oikealle
Musiikin toistaminen Korosta valinta ja paina 2; -painiketta.
Toiston keskeyttäminen Paina toiston aikana 2; -painiketta.
Kappaleen pikahaku eteenpäin Paina painike puoleenväliin ja pidä siinä 4 

Kappaleen pikahaku taaksepäin Paina painike puoleenväliin ja pidä siinä 3 

Äänenvoimakkuuden muuttaminen Paina VOLUME + / -painiketta – 
Seuraavan tai edellisen Seuraava kappale 4 -painikkeella ja edellinen 
kappaleen toistaminen 3 -painikkeella
SuperScroll™ Paina 3 - tai 4 -painike puoliväliin alas ja pidä se alhaalla

23
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Asetusten mukauttaminen

1 Avaa asetukset painamalla MENU/HOLD -painiketta. Selaa haluamasi asetuksen 
kohdalle painamalla 3 - tai 4 -painiketta. Siirry seuraavalle tai edelliselle valikon 
tasolle painamalla 2 - tai 1 -painiketta.

2 Vahvista valinta painamalla 2 -painiketta.Valinnan kohdalle tulee .

3 Poistu valikkonäytöstä painamalla MENU/HOLD - tai 1 -painiketta. Jokaisen 
toiminnon asetusvaihtoehdot näkyvät hdd-kiintolevyn näytössä.

Satunn / uusinta Toista kappaleet satunnaisessa järjestyksessä (satunnaistoisto) 
tai toistuvasti (uusinta).

DBB Ota käyttöön tai poista käytöstä Dynamic Bass Boost

Uniajastin Määritä aika, jolloin hdd-soittimen virta katkeaa.

Taajuuskorjain Säädä ääniasetuksia

[>] näpp. oikopolku Säädä 2 -painikkeen toimintoja toistan aikana 
(Oletusasetus: Satunn / uusinta)

Display (Näyttö) Säädä aika, jonka kuluttua näyttö tummenee, ja näytön kontrastitaso

Autom.lopetus Määritä aika, jonka kuluttua hdd-soittimen virta katkeaa automaattisesti.
Toiminto säästää akkua.

Kieli Määritä hdd-soittimen näyttökieli

Tietoa Näytä hdd-soittimen tiedot

Restore settings Palauta tarvittaessa hdd-soittimen tehdasasetukset vianmäärityksen 
yhteydessä

Lisäasetukset ja -toiminnot
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Radiotila: automaattinen viritys
(vain radiomalleille)

1 Siirry radiotilaan valitsemalla juurivalikosta RADIO.
Kun siirryt radiotilaan, musiikin toisto lakkaa.

2 Paina MENU/HOLD ja valitse Autosearching [Automaattiviritys].
Kun painat seuraavaksi painiketta 2 soitin etsii ja virittää automaattisesti 10 parhaiten 
kuuluvaa radioasemaa.Voit keskeyttää toiminnon painamalla mitä tahansa painiketta.

3 Voit selata esiasetuksia ylöspäin painamalla 3 ja alaspäin painamalla 4 .

4 Korosta pikavalinta ja odota 2 sekuntia.
Voit nyt kuunnella valitsemaasi pikavalintakanavaa.

Radiotila: Manuaalinen viritys
(vain radiomalleille)

1 Siirry radiotilaan valitsemalla juurivalikosta RADIO.
Kun siirryt radiotilaan, musiikin toisto lakkaa.

2 Voit selata esiasetuksia ylöspäin painamalla 3 ja alaspäin painamalla 4 .

3 Paina MENU/HOLD ja valitse Manual tuning (manuaalinen viritys).

4 Voit hienosäätää taajuutta painikkeilla 4 ja 3 .
Voit tallentaa asetukset valitsemalla 1 .
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Hdd-soittimen käyttäminen ulkoisena kiintolevynä

Hdd-soitinta voi käyttää ulkoisena kiintolevynä minkä tahansa tiedostojen tallennukseen ja
siirtämiseen. Huomaa, että Windowsin Resurssienhallinnan avulla tietokoneesta siirrettyjä
musiikkitiedostoja ei voi toistaa hdd-soittomella. Käytä musiikin siirtämiseen aina laitteen
mukana toimitettua ohjelmistoa.

VIHJE
0 On suositeltavaa käyttää tuotteen mukana toimitettua virtasovitinta aina 

USB-yhteyden aikana. Näin vältetään tietojen menetykset.
0 Irrota USB-asema aina ohjeiden mukaisesti. (Katso kohta 5, sivu 19.)

➯
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VAROITUS:
Älä avaa laitetta, sillä seurauksena voi olla sähköiskuvaara. Älä missään tapauksessa yritä korjata laitetta itse,
sillä se mitätöi takuun.

Vianmääritys 
Jos laitteessa ilmenee vika, tarkista ensin seuraavilla sivuilla luetellut asiat.
Lisätietoja ja muita vianmääritysohjeita voi myös olla hdd-soittimen usein 
kysytyissä kysymyksissä osoitteessa www.philips.com/support.
Jos ratkaisua ongelmaan ei löydy näiden vihjeiden avulla, ota yhteyttä 
jälleenmyyjään tai palvelukeskukseen.

K. Hdd-soitin ei vastaa.
Palauta laitteen tila painamalla ja pitämällä alhaalla 3 + [VOLUME +] -painiketta.
Tämä laitteen tilan palautus ei vaikuta millään tavalla hdd-soittimessa olevien tiedostojen sisältöön,
esimerkiksi lauluihin tai ladattuihin tiedostoihin.

K. Hdd-soittimen toistoaika on lyhyt.
Ajan mittaan soittimen ladattava akku heikkenee.Akun voi vaihtaa. Ota yhteyttä Philips-asiakaspalveluun.

K. Hdd-soittimessa näkyy tämä kuvake [file error].
Laitteessa on tiedostovirhe: järjestelmätiedostoja voi puuttua tai hdd-soittimessa ä 
on alustusvirhe. Korjaa virhe, varmista, että kytket hdd-soittimen tietokoneeseen ja 
Gestione periferiche.Valitse pääikkunassa Restore (Palautus).

K. Hdd-soittimessa ä näkyy tämä kuvake [disk error].
Hdd-laitteessa on vakava virhe, joka voi johtua viallisesta kiintolevystä.
Ota yhteys jälleenmyyjään tai palvelukeskukseen.

K. Mistä tiedän, mikä laiteohjelman versio soittimessa on?
Hae näyttöön FW vers: (Laiteohjelman versio:) valitsemalla MENU/HOLD ➔ Asetukset ➔ Tietoa.

K. Mistä tiedän, kuinka paljon vapaata levytilaa on jäljellä?
Hae näyttöön Free: (Vapaana:) valitsemalla MENU/HOLD ➔ Asetukset ➔ Tietoa.
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Käyttöturvallisuus ja huolto

Jotta voit käyttää tuotetta parhaalla mahdollisella tavalla, tutustu myös 
laitteen mukana toimitettuihin tärkeisiin turvallisuusohjeisiin, joita on 
Käyttöturvallisuus- ja takuuoppaassa.

Tietoja käyttö- ja säilytyslämpötiloista

0 Käytä hdd-soitinta aina paikassa, jonka lämpötila on 0-35 ºC.
0 Käytä hdd-soitinta aina paikassa, jonka lämpötila on -20-45 ºC.
0 Hdd-soittimen akun käyttöikä voi lyhentyä matalissa lämpötiloissa.
0 Älä altista laitetta korkeille lämpötiloille tai suoralle auringonvalolle.
0 Kun käytät hdd-soitinta, kytket sen tietokoneeseen tai lataat akkua, hdd-soittimen 

lämpeneminen on normaalia. Kuoren takapaneeli toimii jäähdyttävänä pintana, joka siirtää
lämpöä laitteen sisältä viileämpään ulkoilmaan.

0 hdd-soitinta ei suositella käytettäväksi rankkojen liikuntasuoritusten aikana. Hdd ei ole
iskunkestävä ja voi vaurioitua liian kovasta tärinästä.

Kuulokkeiden käyttäminen

0 Kuunteluturvallisuus
Käytä kohtuullista äänenvoimakkuutta. Jos käytetään suurta äänenvoimakkuutta, kuulo voi
heikentyä.

0 Liikenneturvallisuus
Älä käytä laitetta ajon tai pyöräilyn aikana, sillä seurauksena voi olla onnettomuus.

0 Parhaan mahdollisen toiston saavuttaminen
On suositeltavaa käyttää hdd-soittimen kanssa vain PHILIPS-kuulokkeita. Sopivaa musiikin
äänenvoimakkuutta ja hyvää laatua ei voi taata muilla kuin PHILIPS-kuulokkeilla.
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Vaurioiden ja toimintahäiriöiden välttäminen

0 Ota tiedostoista varmuuskopiot.Varmista, että säilytät alkuperäiset tiedostot 
hdd-soittimeen ladatuista tiedostoista. Philips ei vastaa menetetystä sisällöstä, jos 
tuote vauroituu tai kiintolevyä ei enää voi lukea tai käyttää.

0 Vältyt ongelmilta, kun hallitset tiedostoja (esimerkiksi siirtämistä ja poistamista) laitteen
mukana toimitetulla ohjelmistolla.

0 Älä pudota hdd-soitinta tai pudota mitään sen päälle.
0 Älä upota hdd-soitinta veteen. Älä altista liitäntöjä vedelle.

Vesi voi vahingoittaa laitetta vakavasti.
0 Puhdista hdd-soitin hieman kostutetulla kankaalla.

Älä käytä puhdistusaineita, joissa on alkoholia, ammoniakkia, bentseeniä tai 
hankaavia aineita, sillä ne voivat vahingoittaa hdd-soittimen pintaa.

0 Matkapuhelimen käyttäminen laitteen läheisyydessä voi aiheuttaa häiriöitä.

Verkkolaitteen / laturin käyttäminen

0 Käytä vain hdd-soittimen mukana toimitettua verkkolaitetta. Muiden 
sähkölaitteiden verkkolaitteet voivat näyttää samalta, mutta ne voivat vaurioittaa 
hdd-soitinta.

0 Ainoa tapa katkaista täysin virrantulo verkkolaitteeseen / laturiin on irrottaa laite 
tai laturi pistorasiasta.

0 Jätä aina tilaa verkkolaitteen ympärille. Älä käytä sitä paikassa, jossa ilmankulku 
verkkolaitteen ympärillä on estynyt, esimerkiksi kirjahyllyssä.

0 Kun kytket tai irrotat verkkolaitteen, pitele verkkolaitetta aina sen sivuista.
Älä koske sormin liitännän metalliosiin.

0 Hdd-laitteen verkkolaite on korkeajännitelaite, jota ei saa avata missään tapauksessa, ei
edes silloin, kun hdd-soittimen virtaa ei ole kytketty.
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Tekniset tiedot

Järjestelmä
Tuloteho 2 x 5 mW (16 Ω)
Taajuusvaste 20-20 000 Hz
THD 0.01%- 0.1%
Taajuuskorjain 5-kaistainen DSP-ohjattu
USB-yhteys USB 2.0 full speed
Näyttö mustavalkoinen 128 x 96 pikseliä
Taustavalo valkoinen LED
Akku vaihdettavissa (Philips-huollossa) 750 mAh Li-Ion
Linssit karkaistu optinen lasi
Kuori ruiskuvalettu magnesium
Liitännät stereokuulokkeet, mini-USB (B-tyyppi), laturin liitäntä
Tallennusväline kiintolevy 1,0 tuuman mikro-HDD
Tuetut toistettavat tiedostomuodot
MP3 8-320 kbps ja VBR
WMA 32-192 kbps
Näytteenottotaajuudet 8; 11,025; 16; 22,050; 32; 44,1; 48
ID3-tunnusten tuki kyllä kyllä
Tietokoneliitäntä USB 2.0 full speed

Yleisdatan siirtäminen Windowsin Resurssienhallinnan avulla 

Musiikin siirtäminen Laitteen mukana toimitetulla ohjelmistolla
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Virtalähde
sisäinen 750 mAh uudelleenladattava litiumioniakku (Li-Ion), vaihto Philipsin 
valtuuttamassa huollossa

monijännitteinen verkkolaite/laturi AY3192

Akun käyttöaika
10 tuntia sisäisellä ladattavalla akulla (4 tunnin täyden latauksen jälkeen. Pikalataus: 1 tuntia.)
Akun käyttöikä voi vaihdella käytön mukaan.

Virrankulutus
Virrankatkaisu: alle 1,3 mW
Käytössä keskimäärin (USB-tila): 1,45 W 
Käytössä keskimäärin (toistotila): 250 mW

* Ei ole suositeltavaa käyttää hdd-soitinta akulla USB-yhteyden aikana.

Virittimen taajuusväli FM 87.5 - 108 MHz, Pikavalinnat: 10
(vain radiomalleille)

Yleistä
Mitat 54,3 (L) x 84,5 (P) x 18,3 (K) mm
Paino 93 g

PHILIPS pidättää oikeuden muuttaa tuotteen parantamiseksi sen ulkoasua ja teknisiä tietoja
ilman ennakkoilmoitusta.

Muut kuin valmistajan valtuuttamat muutokset voivat mitätöidä käyttäjän käyttöoikeuden
tähän laitteeseen.

Kaikki tavaramerkit ja rekisteröidyt tavaramerkit ovat omistajiensa omaisuutta.

Kaikki oikeudet pidätetään.
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Tekijänoikeustiedot
0 Internet- ja CD-tallenteiden luvaton kopiointi ja jakelu voi olla tekijänoikeuslakien

ja kansainvälisten sopimusten vastaista. Hdd-soitinta saa käyttää vain 
henkilökohtaiseen käyttöön.

0 Isossa-Britanniassa ja eräissä muissa maissa tekijänoikeudella suojatun aineiston 
kopioimiseen tarvitaan tekijänoikeuksien omistajien lupa.

Ympäristöä koskevia tietoja

Kaikki tarpeeton pakkausmateriaali on jätetty pois. Pakkaus voidaan erottaa helposti neljä 
materiaaliksi: pahvi, polystyreeni, PET ja muovi.

Laitteesi sisältää materiaaleja, jotka voidaan kierrättää, jos niiden hajoitus annetaan tähän tehtävään
erikoistuneen yhtiön suoritettavaksi.

Noudata paikallisia pakkausmateriaalien, tyhjien paristojen ja käytöstä poistettujen laitteiden 
hävitystä koskevia säännöksiä.

Tämä tuote on Euroopan unionin radiohäiriöitä koskevien vaatimusten mukainen.
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Tietoja Musicmatch® Jukebox-ohjelmasta

Tällä palkitulla ohjelmistolla on helppo muuntaa CD-levyt MP3-muotoon, hallita digitaalista 
musiikkikokoelmaa ja siirtää musiikkia laitteisiin.

Huomautus:
Muulla kuin Musicmatch(r) Jukebox -ohjelmalla laitteeseen siirrettyä musiikkia ei voi toistaa.

Asenna Musicmatch® Jukebox ja Device Manager

Pane tuotteen mukana toimitettu CD-levy tietokoneen CD-asemaan.1

Suorita asennus noudattamalla näyttöön tulevia ohjeita.2

Täytä kohoikkunan tiedot.3

Musicmatch® Jukebox-ohjelman avaaminen

Liitä laite tietokoneeseen vakiovarusteena olevalla USB-kaapelilla.
Näyttöön tulee automaattisesti USB-yhteyden näyttö.

1

Musicmatch® Jukebox-ohjelman avaaminen.2

VIHJE

Voit selvittää USB-portin sijainnin tietokoneesi käyttöoppaasta.
Etsi USB-symboli tietokoneen keskusyksiköstä.

✔

Tietoja Device Mangager-ohjelmasta

Device Manager -sovelluksella voit päivittää ja palauttaa laitteen alkuperäiset tiedot 
muutamalla napsautuksella.
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Päänäyttö

2

6

Avattavia valikoita: toimintojen käyttäminen1

Soitinikkuna: näyttää raidan tiedot ja sisältää perusohjaimet2

*Näytön ulkoasu vaihtuu käyttötarkoituksen mukaan

31 54

7

Soittoluetteloikkuna: näyttää soittoluettelon tiedot3

Tekstiruutu: kirjoita hakuteksti tähän4

Pienennys- ja suurennuspainikkeet: Musicmatch®-näkymän pienentäminen ja suurentaminen /
Musicmatch®:n sulkeminen

5

Kirjastoikkuna: näyttää kirjastotiedot6

Kannettava laite: kutsuu Portable Device Manager -sovelluksen7
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Raitojen hakeminen ja lisääminen kaikista asemista
(kirjastoon)

Siirry valikkoon Options > Music Library > Search and Add Tracks From All Drives
(Asetukset > Musiikkikirjasto > Etsi ja lisää raitoja kaikilta asemilta).

1

Hae musiikkitiedostoja valitsemalla Look In (Hakukohde) -kentästä All Drives (Kaikki asemat)
(tai jokin tietty asema).Valitse haluamasi asetukset ja käynnistä haku valitsemalla OK.

2

Tiedostot lisätään kirjastoon.3

*Näytön ulkoasu vaihtuu käyttötarkoituksen mukaan

Musicmatch® Jukebox etsii musiikkitiedostoja tietokoneen kiintolevyltä tai kaikilta käytettävissä 
olevilta kiintolevyiltä.
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Raidan lisääminen soittolistaan vetämällä ja pudottamalla

Voit korostaa vaihtoehdon nasoittimenuttamalla sitä.1

Vedä valinta soittoluetteloikkunaan.2

Valittu raita on nyt soittolistassa.Toisto aloitetaan.3

VIHJE
Voit valita useita kohteita pitämällä Ctrl-näppäintä painettuna kohteita valitessasi.
Jos haluat valita useita peräkkäisiä kohteita, nasoittimenuta ensin ensimmäistä kohdetta,
pidä vaihtonäppäintä painettuna ja nasoittimenuta sitten viimeistä kohdetta.

✔

*Näytön ulkoasu vaihtuu käyttötarkoituksen mukaan
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Raitojen ja soittolistojen poistaminen

Voit korostaa vaihtoehdon nasoittimenuttamalla sitä.1

Napsauta hiiren kakkospainiketta ja valitse Remove tracks to delete (Poista valitut raidat).2

Toinen tapa poistaa kohde on valita se ja painaa sitten näppäimistön Delete-näppäintä.3

*Näytön ulkoasu vaihtuu käyttötarkoituksen mukaan

VIHJE
Voit valita useita kohteita pitämällä Ctrl-näppäintä painettuna kohteita valitessasi.
Jos haluat valita useita peräkkäisiä kohteita, nasoittimenuta ensin ensimmäistä kohdetta,
pidä vaihtonäppäintä painettuna ja nasoittimenuta sitten viimeistä kohdetta.

✔
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Raitatietojen muokkaaminen

Aloita raidan tietojen muokkaus nasoittimenuttamalla muokattavaa raitaa.1

Napsauta hiiren kakkospainiketta ja valitse raitatietojen muokkausikkunassa Edit Track Info...
(Muokkaa raidan tietoja...).

2

Muokkaa tietoja napsauttamalla muokattavaa tietoa.3

Tallenna tiedot valitsemalla OK to save the information. Voit peruuttaa tekemäsi muutokset
valitsemalla Cancel [Peruuta].

4

*Näytön ulkoasu vaihtuu käyttötarkoituksen mukaan

VIHJE
Voit myös napsauttaa painiketta vaiheessa 2.

✔
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Raitojen etsiminen

Kirjoita haettava teksti hakukenttään.1

Aloita haku valitsemalla Go.2

Hakutekstin sisältävät raidat tulevat näkyviin.3

Voit siirtää, poistaa sekä vetää ja pudottaa näitä raitoja normaalisti.4

*Näytön ulkoasu vaihtuu käyttötarkoituksen mukaan
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Lähetä raidat ja soittoluettelot laitteeseen

Valitse Portable Device Manager valitsemalla File > Send to portable device

(Tiedosto > Lähetä kannettavaan laitteeseen).

1

Vedä ja pudota raidat ja soittoluettelot Portable Device Manageriin.2

Valintasi siirretään laitteeseen.3

VIHJE

Voit siirtää soittoluettelot suoraan laitteeseen napsauttamalla soittoluetteloikkunassa painiketta

.

Jos haluat lisätietoja Musicmatch® Jukeboxista, valitse Help > Musicmatch Jukebox Help
(Ohje > Musicmatch Jukebox Help).

✔

*Näytön ulkoasu vaihtuu käyttötarkoituksen mukaan

DM_MMJB_suo.qxd  24/11/04  9:52  Page 8



9

Päivitykset

Tulet varmasti nauttimaan tuotteestasi pitkään. Parhaimman tuloksen takaamiseksi suosittelemme, että 
tarkistat säännöllisesti sivustosta www.philips.com, onko tuotteeseen tullut uusia, maksuttomia 
ohjelmisto- tai laiteohjelmistopäivityksiä.

Laiteohjelman päivitys

Laitteen toimintaa ohjaa sisäinen laiteohjelma. Laitteen voi päivittää lataamalla ja asentamalla siihen
laiteohjelmapäivityksiä.

Liitä laite tietokoneeseen (virtalähteenä voi olla vakiovarusteinen verkkolaite). Käynnistä
Device Manager valitsemalla Start (Käynnistä) ➔ Program (Ohjelma) ➔ Philips ➔

xxx ➔ xxx (xxx = mallinumeron)

2

Valitse pääikkunassa Upgrade (Päivitys).3

MUISTUTUS!
Lataa laite täydellisesti ennen laiteohjelmiston päivitystä. Tämä takaa, että virtaa riittää koko
prosessin suorittamiseen.

✔

Sinua pyydetään irrottamaan laite tietokoneesta heti, kun Device Manager ei enää ole yhteydessä

laitteeseen. Voit irrottaa laitteen turvallisesti napsauttamalla tehtäväpalkissa painiketta .

4

Kun USB-kaapeli on irrotettu, laiteohjelmiston päivitys käynnistyy automaattisesti.
Päivitys on valmis, kun laite käynnistyy uudelleen ja virtaikkuna näkyy hetken.

5

Käy osoitteessa www.philips.com/support. Saatat joutua kirjoittamaan mallinumeron, jotta voit
käyttää päivitystiedostoja.Varmista, että tallennat tiedostot tietokoneessa olevaan kansioon.
Pura tiedostot ennen päivitysten asentamista.

1

WINDOWS XP / 2000 -käyttäjät:
Laite irrotetaan automaattisesti heti, kun Device Manager on päättänyt yhteyden 
laitteeseen.
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Musicmatch® Jukebox -päivitys

Musicmatch® Jukebox on soittimen ja tietokoneen välinen yhteysohjelma. DMM-ohjelmaan saattaa olla
saatavilla päivityksiä.

Valitse vaihtoehdot Upgrade [päivitykset]. Näkyviin tulee tietoja 
Musicmatch® Jukebox-päivitysten lataamisesta ja asentamisesta.

1

Päivitä Musicmatch® Jukebox-ohjelma noudattamalla näyttöön tulevia ohjeita.2

Musicmatch® Jukebox:n asennuksen poistaminen 

Sulje kaikki sovellukset, myös Musicmatch® Jukebox.1

Valitse ensin Käynnistä ja sitten Ohjauspaneeli. Valitse Lisää tai poista sovellus.
Aloita Musicmatch® Jukebox:n asennuksen poisto valitsemalla se asennettujen sovellusten
luettelosta.

2

Lisätietoja ohjelmien poistamisesta on Windowsin käyttöoppaassa.3
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Laitteen palautus

Laitteen toimintaa ohjaa sisäinen laiteohjelma. Jos laiteohjelmistotiedostot ovat 
vaurioituneet, sinun on ehkä palautettava laitteen alkuperäiset tiedot.

Liitä laite tietokoneeseen (virtalähteenä voi olla vakiovarusteinen verkkolaite). Käynnistä
Device Manager valitsemalla Start (Käynnistä) ➔ Program (Ohjelma) ➔ Philips ➔

xxx ➔ xxx (xxx = mallinumeron)

1

Valitse pääikkunassa Restore (Palautus). Sinua pyydetään irrottamaan laite tietokoneesta
heti, kun Device Manager ei enää ole yhteydessä laitteeseen.

2

Voit irrottaa laitteen turvallisesti napsauttamalla tehtäväpalkissa painiketta .3

Kun USB-kaapeli on irrotettu, laitteen palautus käynnistyy automaattisesti. Päivitys on valmis,
kun laite käynnistyy uudelleen ja virtaikkuna näkyy hetken.

4

VIHJE
Lataa laite täydellisesti ennen laitteen palautusta.
Tämä takaa, että virtaa riittää koko prosessin suorittamiseen.

✔

VAROITUS:
Kaikki sisältö ja musiikki poistetaan!
Tee kaikista tiedostoista varmuuskopio ennen laitteen palautusta.

WINDOWS XP / 2000 -käyttäjät:
Laite irrotetaan automaattisesti heti, kun Device Manager on päättänyt yhteyden 
laitteeseen.
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